
ECE145B Design Lab #1 
Mixer Design Project - Winter 2005 

Report Due Jan 28 
 
You are to design, fabricate and test a BJT mixer.  The goal of this lab is for you to 
become familiar with the design tradeoffs that influence conversion gain, noise figure, 
gain compression and intermodulation distortion in mixers, not necessarily to produce the 
world’s best mixer.  The inputs and outputs are wideband in this design, but the target 
application is for an FM receiver at the frequencies shown in the table. 
 
Specification Low end High end 
RF input frequency 88 MHz 108 MHz 
LO frequency 98.7 118.7 
IF frequency 10.7 10.7 
Minimum Conv Gain  6 dB 6 dB 
 
A suggested circuit diagram:  All source and load impedances are 50 ohms.  Capacitors 
are for bypass and DC blocking.  Choose appropriate values for the frequencies in use.  
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1.  Design 
A.  Do a hand analysis of the DC biasing.  R1 – R3 set the bias voltages of the RF and 
LO sections of the Gilbert cell.  REE and VB2 determine the collector current.  RISO is used 
to avoid losing input power into the bias network.  Thus, RISO >> 50 ohms.  Start with IEE 
= 10 mA.  (You will need to explore the dependence of IC on P1dB, so this may change 
later)  VB1 should be set so that the Q1 and Q2 are always in the active region.  VCC must 
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be set to avoid saturation of the LO transistors.  Also, with inductive feed, the peak AC 
collector voltage will exceed VCC, so watch out for breakdown.   
 
MAX RATINGS:  

• VBR,CBO = 20V and ICmax = 50 mA for the 2N5179.  (Refer to the data sheet for 
other parameters.)   

• Note that the RF transformer has a maximum DC current rating of 30 mA.  Data 
sheets for both are attached at the end of this lab. 

 
B.  The RF to IF signal path of the mixer resembles a cascode.  An RF transformer is 
used to transform the 50 ohm IF load impedance to a higher AC load impedance at the 
collectors.  T2 is an RF transformer (T16-6T-W38) that has a turns ratio of 4, for a 16 to 
1 impedance transformation.  Each collector sees ½ of the transformed impedance.  Refer 
to the MiniCircuits App Note: “How RF Transformers Work”, linked from the course 
web page.  The transformer also increases the conversion gain by 6 dB by using the 
differential output. 
 
Transformer T1 is a Minicircuits T4-1-W38, with turns ratio of 2, whose purpose is to 
balance the input and increase conversion gain by driving both RF inputs.   
 
The main difficulty with this design has been stability.  The circuit will oscillate at about 
500 MHz if suitable stabilization is not provided.  RP and Rstab are intended to stabilize 
the mixer RF to IF path and must be used to avoid this condition.  Past experience has 
shown that a compact layout also is helpful. 
 
Make an estimate of the conversion gain using small signal analysis and assuming the LO 
transistors are ideal switches. 
 
The load impedance presented to Q3 – Q6 will determine the maximum current and 
voltage swing, similar to the large signal load line concept in the Class A power amp.  At 
maximum drive, avoid signal swings into the saturation region or into breakdown.  
Estimate the peak current that will be possible for your given load impedance and your 
choice of IEE and VB1. 
 
2.  Circuit Simulation 
Design Goal:  Choose VCC, IEE, VB1, LO power, RED to obtain the highest figure of merit, 
defined for purposes of this lab as  
 

FOM = P1dB – SSB Noise Figure 
 
with a small signal conversion gain of at least +6 dB.  You can assume that P1dB and IP3 
will be related, but simulation time for P1dB is considerably shorter.  While you should 
determine power dissipation, it is not necessary to minimize it in this application.   
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You will be using the 2N5179 bipolar transistor for this mixer.  A model for this device 
can be found in the Analog Parts library of ADS.  Since the frequency range is rather low 
for this application, the models in this library should be adequate for simulation. 
 
After drawing the schematic diagram of your mixer, you will need to make it into a 
subnetwork.  Pay attention to the comment on ADS transformers while you are 
constructing this.  See the pages at the end of this document for directions on how to do 
this.  The benefit will be that you can easily insert the mixer subnetwork into all of the 
ADS Mixer DesignGuide schematic templates.  This will save you hours of work because 
the setup for all of the ADS simulations you will need is already done.  Harmonic 
Balance method will be used for most of these simulations.  Also see the appended 
document on use of the Mixer DesignGuide and the mixer harmonic balance tutorial on 
the web site. 
 
You may want to proceed with the design of the mixer using the following steps.   

a.  Determine the optimum LO input power by simulating P1dB as a function of  
LO power.  You will use the LO sweep option for this simulation.   
b.  Fix the LO power at the lowest value that gets you close to the highest P1dB.  
Evaluate P1dB (conversion gain and gain compression simulation) and single-
sideband mixer noise figure as a function of your other circuit parameters: IEE, 
RED, VB1, VCC.  There will be tradeoffs between conversion gain, noise figure and 
P1dB.  For example, larger IEE gives higher P1dB but also higher NF.  Higher RED 
will increase P1dB but also increases noise figure and reduces conversion gain.   
c.  Once the design space has been narrowed down, you must determine the 
optimum value of RP and Rstab for stability.  The mixer is potentially quite 
unstable and will oscillate at VHF frequencies if stabilizing resistors are 
neglected.  To explore stability, make and rename a modified mixer subnetwork 
where Q4,Q5 are biased off all of the time.  Ground the LO input and now you 
have a cascode amplifier.  Use the same small signal S parameter stability 
analysis that you used in last quarter’s amplifier designs to plot the k factor and 
stability circles.  Don’t make Rp unnecessarily low or you will forfeit conversion 
gain. 
d.  Simulate the IIP3 of the mixer.  Since FM station carriers are separated by 200 
kHz, use this as the frequency separation for the two-tone third-order IMD 
simulation.  
e.  Examine the output spectrum and identify spectral lines up to order 4 (with two 
input frequencies).  Determine LO – RF, LO – IF, and RF – IF isolation. 
 

3.  Construction of the mixer. 
We will be fabricating custom PC boards for lab 1.  This service has been graciously 
provided by the internet PCB vendor, ExpressPCB.  The boards are subject to the 
following restriction: 
 

• The PCB dimensions must be 3.8 x 2.5 inches.  This is their standard 
miniboard size and the only one they will support for this class. 
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• Board material is FR-4.  You should assume εr = 4.5. 
 
You can access the layout software on the PCs in 5162 or ECI.  Or you can download the 
software onto your own PC.  In either case, visit http://www.expresspcb.com for an 
orientation on their layout software and board specifications.  If you use your own PC, 
then you must also download the component footprint (W38.p) for the transformers that 
is found on the course website.  Copy this file into the following directory: 
  Programs\ExpressPCB\PCBComponents_Custom  
 
When your layout is ready to submit, carefully check it against your schematic.  Then 
generate a plot file for manual order (Layout menu). This will catch some of the layout 
errors if they exist.   
 
email BOTH the .pcb and the .plt file to: long@ece.ucsb.edu.  I will submit all of the 
layouts for the class in one batch.  DO NOT SEND AS A .zip FILE.  The department 
server will automatically delete these. 
 

THE BOARD LAYOUTS ARE DUE BY 9 AM ON MONDAY, JAN. 17. 
 
4.  Testing the mixer.   
Use generators to test the mixer performance with the IF output connected directly to the 
spectrum analyzer.  Perform the measurements indicated below.   
 

1.  Plot conversion gain vs. LO drive power.    
2.  Plot 1 dB compression input power level (P1dB) vs. LO drive power. 
3.  Measure the frequency response of the RF port.  Adjust both the LO and RF 
frequencies to find out the upper 3 dB frequency for your mixer while keeping the 
IF frequency fixed at 10.7 MHz. 
4.  Input intercept point (two-tone IMD measurement).  Use a 2 tone test 
configuration to determine the third order input IMD intercept.  Use the same 
frequency plan as you used for the simulation. (Note that you will need to use 3 
generators for this measurement; one for the LO and 2 for the inputs).  
5.  Identify spectral lines up to 1 GHz and measure LO – RF, LO – IF, and RF - 
IF isolation. 

 
Finally, connect the mixer to the FM IF/demodulator/audio amplifier box, attach a clip 
lead to the mixer input, and see how many FM stations you can tune in.  Or, if you want 
to try to measure DSB NF with the spectrum analyzer, see the TAs or Prof. Long. 
 
5.  Report. 
Refer to the course introduction for expectations on reports.  The report must include a 
section on your design and simulation efforts.  Describe the effect of the various tradeoffs 
in design parameters, predict the performance of your mixer, and compare measurement 
with simulation. 
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Parts list for ECE145B    Mixer Design Lab    Winter 2005 

 
1 Minicircuits T16-6T-W38 RF Transformer 
1 Minicircuits T4-1-W38 RF Transformer 
6 2N5179 
3 10 uF  Tantalum Caps 
3 board mounted SMA connectors 
24” Pair of insulated wires for power connection.  

2N5179 

 
Comments on transformers in ADS. 
 

 ADS, the ideal center-tapped transformer is the TF3 icon in the components menu.  

 

 
In
For some unknown reason, however, the turns ratio is inverted from what you would 
expect to see.  The primary side always is 1.  The secondary windings are specified as
1/T1 and 1/T2.  Hence, the T16-6T transformer, which has a total turns ratio of 4 
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(impedance transformation of 16), is specified as above.  Each half of the seconda
should have a ratio of 2, thus T1 = T2 = 0.5.  This is a frequent source of confusion! 
 

ry 

he ratio of V2/V1 and V3/V1 should ideally be N = 1/T1 = 1/T2.  The impedance 
ce 

Appendix 1:  Defining a Subnetwork in ADS: 
 

ubnetworks allow you to take advantage of the heirarchy possible in ADS.  You can 
n 

ere are the steps: 

egin from your schematic of the circuit that you want to represent as a subnetwork. 

.  Insert and label connectors  from the tool bar.  In a mixer, port 1 is the RF port, 2 is the 

T
presented to ports 2 and 3 is ½ of the total transformed impedance.  Thus, if the sour
impedance at the primary is 50 ohms, you should see 400 ohms at ports 2 and 3. 

S
save circuits or portions of circuits that you plan to reuse as subnetworks which can the
be accessed in the Component Library. 
 
H
 
B
 
1
IF and 3 is the LO port.  
 

 
Complete the construction of your schematic for the subnetwork.  Note that you will need 

.  .  Create Subnetwork symbol: 
atic Symbol 

 Click on the Copy/Modify Tab 
tem-Amps 

e schematic, choose View > Create/Edit Schematic Symbol (again) 

 
. Name the circuit and set the design parameters 

General tab

to include transistor models into the subnetwork if your circuit requires transistors.  Name 
and save the subnetwork. 
 
2
 View > Create/Edit Schem

The Symbol Generator panel opens up. 
There is a library of symbols already available.  For a mixer, use the Sys
& Mixers lib. 
To return to th
Save the file 

3
 File > Design Parameters 
 
 .   The component name will be shown, BJT_SB in this example.  

Name the component instance.  For example: Mix.   When the component is 
included in a schematic, each instance will be numbered sequentially. 
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5.  If you want to allow adjustable parameters from outside the subnetwork, use the 

arameters menu tab.  This is useful when you want to sweep some parameter that is 
side the subnetwork.  In this example, 4 parameters are declared to be adjustable. Their 

atic 

  

P
in
values are given a default, but can be specified again outside the model in the schem
where it is being used. 
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6.  Save the subnetwork again.   
 
7.  To insert your mixer into the schematic, use the component library icon (the bookshelf 
icon) on the tool bar to open the library.  Select your project, then the component you 
wish to insert.  You can then point and click into the schematic. 
 

 
The symbol appears like this in the schematic: 

 
7.  You can push into the subnetwork to view or modify it with the down arrow icon on 
the toolbar. 

 
Rev:  January 2003 
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ADS Tutorial:   Using the Mixer Design Guide 
 
Agilent provides all ADS users with a large selection of “Design Guides” covering many 
areas of interest in microwave circuits and communications.  These DGs consist of a 
collection of schematic and display templates that are preconfigured for relevant 
simulations.  As you will quickly see, you can save days or weeks of time by importing 
the most relevant schematic/display pair and modifying it for your own application 
instead of starting from nothing. 
 
To import into your ADS project, use the DesignGuide menu.   
 

 
 
When you highlight and click, the menu expands as shown below. 
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You will find a large selection of mixer characterization templates and example mixers.  
These are grouped according to differential or single-ended mixer interfaces.  Within 
each group, you will find 4 categories of measurements, all using the harmonic balance 
simulation mode. 

ept) simulations or 

2.  Mixer Characterization vs. LO Power.  The same set of simulations with the 
LO power swept. 
3.  Mixer Characterization vs. Input Frequency.  RF Input frequency is swept. 
4.  Mixer Characterization vs. Swept Parameter.  Use this if you want to 
evaluate some aspect of mixer performance as a function of any other swept 
parameter (bias voltage or current, component value, device widths, etc.) 

 
Within each category, there is a set of 7 measurement templates. 

a.  IF Spect, Isolation, Conv. Gain, Port Impedances.  Spectral display of the IF 
output; LO – IF, LO – RF, and RF – IF isolation; Conversion gain at fixed input 
power; small signal input impedances. 
b.  Conv. Gain Gain Comp. vs. Input Power.  Simulate conversion gain plot 
gain compression while sweeping the RF input power. 
c.  N-dB Gain Compression.  A more limited version of b.  No plots, just a table. 
d.  2nd and 3rd order IMD and Conv. Gain.  Simulate two-tone intermodulation 
power and intercepts with a fixed RF and LO input power.   

 
1.  Mixer Characterization.  These are either fixed (non-sw
they are RF input power sweeps. 

 10



e.  2nd and 3rd order IMD and Conv. Gain. Vs. Input Power.  This performs the 
RF power sweep and plots fundamental, 2nd order, and 3rd order powers on a dB 
vs. log freq. plot. 
f.  SSB Noise Figure and Conv. Gain.   A harmonic balance single sideband 
noise figure simulation.  This accounts for large signal effects and mixing of noise 
from LO harmonics.   
g.  All Sideband Noise Figure and Conv. Gain.   This uses the hot-cold noise 
figure simulation method and calculates a double-sideband NF, again using 
harmonic balance. 
 

When you select one of the template pairs, it will import the files into your ADS project.  
You are then free to modify it for your own application.  Paste in your own mixer in 
place of the default one.  Modify frequencies, powers, change parameters, sweeps etc. as 
needed. 
 
Convergence Woes 
 
Any user of the harmonic balance simulator will eventually encounter convergence 
problems.  Unfortunately, when this happens, no useful information is provided by the 
simulator.  Problems with convergence generally arise when the circuit under simulation 
is or becomes highly nonlinear.  In the case of mixers, there are inherent nonlinearities 

at are required for the mixing process, but these are usually not so bad unless you are 

f this d
See the
 
 
Rev:  Jan
 

th
seriously overdriving one of the inputs.  If the simulation fails, check the biasing of the 
transistors.  HB doesn’t do well with BJTs driven into their saturation region; try 
decreasing either LO power or the maximum RF power input.  You may be driving the 
mixer well beyond saturation when using default power levels in mixer DG templates.   
 
I oes not succeed, you can use a transient assisted harmonic balance technique.  

 course web site for an example. 

uary 2005 
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